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We hear it all the time, people want to know what reports other 
customers love and use. So, we reached out and you answered!
 
Together we've created the first ever Adobe Workfront Customer 
Cookbook. Inside you'll find 10 useful reports to explore. We have 
simple reports, complex reports, reports with text mode, reports 
without text mode, and even a dashboard combining 6 different 
reports! 

Take these recipes, try them out in your own Workfront reporting 
kitchen, and just like any good recipe, make it your own! Then, 
share what you learn or what you create with your fellow work 
management experts on the Adobe Workfront Community. 
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Open Tasks By Assignment
R E P O R T  R E C I P E S

Submitted by: Kathy McLaughlin

Company: Mayo Clinic Alix School of Medicine

Prep: less than 10 minutes

Yield: Shows all new and open tasks for a specific user. Great to use when tasks need to be 
reassigned.

Serves: Project Owners

Report type: Task

Report recipes  |  Open Tasks by Assignment
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Open Tasks By Assignment
Detailed instructions

Report recipes  |  Open Tasks by Assignment

Step 1: From the reports area, choose a new Task Report. Add the following task fields as columns to 
the report: 

•	 Name

•	 Assignments

•	 Start On (The field to choose is Planned Start Date, it auto renames to Start On.)

•	 Due On (The field to choose is Planned Completion Date, it auto renames to Due On.)

•	 Status

•	 Percent complete

•	 Last Note>> Note Text

Step 2: Group the report by Project: Name Charts: No charts needed for this report.

Step 3: Set filters to Task: Status not equal to Complete. Basically, remove tasks that have been 
completed.

*Note from Workfront: Because every customer might have unique custom statuses that equate with 
Complete, the best way to handle this is to use a filter which will account for any statuses or custom 
statuses that equate with Complete. Try using this filter: Task >> Is Complete >> Equal >> False

See next page for more directions and the final product.
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Open Tasks By Assignment
Detailed instructions

Report recipes  |  Open Tasks by Assignment

Step 4: From the Report Settings area, select Report Prompts. Choose Assignment Users: ID from the 
field library. This allows you to view results for a specific user on the Prompts tab when the report is run.

Step 5: Give your report a name and include a description. A description helps anyone the report has 
been shared with to understand its purpose. 

Final product

Don't forget to share this report once you've finished it.



6

Most Recent Update
R E P O R T  R E C I P E S

Submitted by: Jonathan Hobbs

Company: Fannie Mae

Prep: 10 minutes

Yield: This report will give the viewer an abbreviated look (140 character limit) at the last 
update entered for an object. It also will include who made the entry and when the entry 
was submitted.

Serves: This is for people who want their "Last Note" column height and width to be 
consistent across all rows.

Report type: Project, Task or Issue

Report recipes  |  Most recent update
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Most recent update
Detailed instructions and final product
Step 1: Add the Last Note column to a report (Either a project, task, or issue report of your choice). The 
same text mode works in all these report types.

Report recipes  |  Most recent update

Groupings: No groupings needed

Filters: No filters needed

Charts: No charts needed

Step 2. Switch to text mode and add the following text mode: 

displayname=Last Note
querysort=lastNote:entryDate
textmode=true
valueexpression=IF(LEN({lastNote}.{noteText})>140, CONCAT(SUBSTR({lastNote}.{noteText},0,139),"...(open 
for more) -- ", {lastNote}.{owner}.{name}," on ", {lastNote}.{entryDate}), IF(LEN({lastNote}.{noteText})>0, 
CONCAT({lastNote}.{noteText}," -- ", {lastNote}.{owner}.{name}," on ", {lastNote}.{entryDate})))
valueformat=HTML
width=250
usewidths=true

**Note from Workfront: When copying and pasting text mode 

from this Cookbook PDF into your Workfront report, a new line 

character (which is a line break) is inserted at the end of the 

first two lines of the valueexpression. You will need to remove 

the new line characters to ensure that the text mode delivers 

accurate results.

Final product
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Team Members Tasks By Project
R E P O R T  R E C I P E S

Submitted by: Benetta Perry

Company: Automatic Payroll Systems Inc (APS)

Prep: 30 minutes

Yield: Each day, new and experienced team members alike will know what tasks are ready for them 
to perform, the due dates of each task, and which project the task belongs to. In addition, project 
managers will be able to see which tasks are late.

Serves: Project team members

Report type: Task

Report recipes  |  Team Members Tasks By Project 

Ready to Start
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Team Members Tasks By Project
Detailed instructions

 Step 1: Create a custom task status. From Setup, select Project Preferences, select Statuses, select 
the tab Tasks and click  ”add a new status”. Here is where you would create your unique task status. 
In my example “Ready to Start”. I have equated it as new. Click save. 

Report recipes  | Team Members Tasks By Project 

Step 2: Create task report

Columns: No text mode is required. Just make sure you have one column for Planned Completion 
Date and one column for Progress Status. You can customize the display name of one column and 
change the background color of one column.

See next page for detailed instructions.

Step 3: Using the Advanced Options: I renamed the display name of the out-of-the-box column 
“planned completion date” to “Task Due Date”.

Step 4: Using the Advanced Options: I changed the background color of the column “Progress 
Status” if the status was “late”.
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Team Members Tasks By Project
Step-by-step directions

Step 5: Filters: No text mode is required. Filter on the team member who this task report is for and 
filter using the newly created customized task status. In order to make this work for any user, filter on 
the wildcard $$USER.ID instead of a person's name.

Report recipes  |  Team Members Tasks By Project 

See next page for final product.

Step 6: Groupings: Group by Project Name, then by Parent Name.

Step 7: Charts: No charts needed
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Team Members Tasks By Project
Final product

Report recipes  |  Team Members Tasks By Project 

As you assign the team member “Benetta Perry” to additional tasks and change the status to 
Ready to Start, this report will show all tasks and be grouped by Project. 

Every task assigned will have a due date which comes from the project. Changing the background 
color on a “late” task gives the team member and Project Manager a talking point in determining 
the reason for that task not being completed as expected.  

Providing the task due dates also helps the team member with prioritization of their daily duties. 
It also tells them where they need to be focused that day and that week. Late tasks could indicate 
a performance issue, a workload balancing issue, a dependency not received issue, a flow of 
communication issue, or a project schedule issue. 

Once the team member completes the work, they change the status to “complete” and it is 
removed from their report. Our teams love this report, as there is no confusion on who should be 
working on what and when. The “late” project status has helped us in improving our processes.
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My Work, Ready to Start
R E P O R T  R E C I P E S

Submitted by: Sarah Nau

Company: Dominium

Prep: 10-15 minutes

Yield: Show your users what tasks they have coming up in the next two weeks or tasks 
that are overdue. This report also shows the project name, parent task name, and the last 
update with who it was made by and when.

Serves: Workers

Report type: Task

Report recipes  |  My Work, Ready to Start
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My Work, Ready to Start
Detailed instructions

Columns: Some of the columns in this report are text mode and some standard Workfront fields. 
First Column combines the Project Name, Parent Name and Task Name through text mode. Select the 
left column and switch to text mode. Copy and paste the text mode from this page, replacing the text 
mode that was in this column previously.

Report recipes  |  My Work, Ready to Start

See next page for more instructions.

column.0.displayname=Task

column.0.linkedname=project

column.0.namekey=view.relatedcolumn

column.0.namekeyargkey.0=project

column.0.namekeyargkey.1=name

column.0.querysort=project:name

column.0.sharecol=true

column.0.textmode=true

column.0.valuefield=project:name

column.0.valueformat=HTML

column.1.sharecol=true

column.1.textmode=true

column.1.value=<br>

column.1.valueformat=HTML

column.1.width=1

column.2.displayname=

column.2.linkedname=parent

column.2.namekey=view.relatedcolumn

column.2.namekeyargkey.0=parent

column.2.namekeyargkey.1=name

column.2.querysort=parent:name

column.2.sharecol=true

column.2.textmode=true

column.2.valuefield=parent:name

column.2.valueformat=HTML

column.3.sharecol=true

column.3.textmode=true

column.3.value=<br><br><b>

column.3.valueformat=HTML

column.3.width=1

column.4.descriptionkey=name

column.4.isInlineEditable=false

column.4.link.linkproperty.0.name=ID

column.4.link.linkproperty.0.valuefield=ID

column.4.link.linkproperty.0.valueformat=int

column.4.link.lookup=link.view

column.4.link.valuefield=objCode

column.4.link.valueformat=val

column.4.linkedname=direct

column.4.listsort=string(name)

column.4.namekey=task.name.abbr

column.4.querysort=name

column.4.section=0

column.4.shortview=true

column.4.stretch=100

column.4.textmode=true

column.4.valuefield=name

column.4.valueformat=HTML

column.4.width=150

Copy the text mode from here:

(This is just the 
continuation of the text 
mode started on the 
column on the left)

Step 1: Create a task report and add filters, columns, groups.
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My Work, Ready to Start
Detailed instructions
Columns continued: 

The next 6 columns are standard Workfront fields, add or replace the existing columns starting with the 
second column from the left:
•	 Description
•	 Planned Hours
•	 Planned Start Date
•	 Planned Completion Date (sort by this column in Ascending order to see the tasks that are due the earliest first)
•	 Status
•	 Percent Complete
Feel free to change these to the columns that helps your team the most! 

Updates Column: Create a new column on the far right. The last column is a text mode column that 
combines the last update, who made it and the date it was made (make sure you have 6 columns between 
the first one and this one so that the column numbers line up correctly – you can remove some later).

Report recipes  |  My Work, Ready to Start

See next page for more instructions.

column.11.displayname=Updates

column.11.linkedname=lastNote

column.11.namekey=view.relatedcolumn

column.11.namekeyargkey.0=lastNote

column.11.namekeyargkey.1=noteText

column.11.querysort=lastNote:noteText

column.11.sharecol=true

column.11.textmode=true

column.11.valuefield=lastNote:noteText

column.11.valueformat=HTML

column.12.sharecol=true

column.12.textmode=true

column.12.value=<br><b>Name: </b>

column.12.valueformat=HTML

column.12.width=1

column.13.displayname=

column.13.linkedname=lastNote

column.13.namekey=view.relatedcolumn

column.13.namekeyargkey.0=lastNote

column.13.namekeyargkey.1=owner:name

column.13.querysort=lastNote:owner:name

column.13.sharecol=true

column.13.textmode=true

column.13.valuefield=lastNote:owner:name

column.13.valueformat=HTML

column.14.sharecol=true

column.14.textmode=true

column.14.value=<br><b>Date: </b>

column.14.valueformat=HTML

column.14.width=1

column.15.displayname=

column.15.linkedname=lastNote

column.15.namekey=view.relatedcolumn

column.15.namekeyargkey.0=lastNote

column.15.namekeyargkey.1=entryDate

column.15.querysort=lastNote:entryDate

column.15.textmode=true

column.15.valuefield=lastNote:entryDate

column.15.valueformat=atDate

Copy the text mode from here: This is just the continuation of the text mode started on the 
column on the left:
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My Work, Ready to Start
Detailed instructions

Report recipes  |  My Work, Ready to Start

Filters: No text mode is required, all are standard Workfront fields

See next page for more instructions.

If you have custom statuses, I highly recommend using the ‘Status Equates With’ filter option instead of 
‘Status’ to avoid having to select all possible ‘Current’ statuses.
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My Work, Ready to Start
Detailed instructions

Report recipes  |  My Work, Ready to Start

See next page for more details.

Groupings: (Optional) No text mode for grouping, all are standard Workfront fields

Make it easy for your users to clearly see what is due each week by grouping your report by the planned 
completion date. 

Charts: I don’t use any for this recipe.
Other Features:
Add some color to your report to show users what is overdue, due today, and what isn’t due until next 
week.
Go to the Planned Completion Date column and click on Advanced Options in the upper right:
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My Work, Ready to Start
Detailed instructions

Report recipes  |  My Work, Ready to Start

See next page for final product.

Step 2: Add conditional formatting with the following rules – don’t forget to check the box for ‘Apply to 
the entire row’!
Late tasks:

Tasks not due this week:

Tasks that are due today:

Select the background 
color you want to indicate 
each status.
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My Work, Ready to Start
Final product

Step 3: Add to any dashboard or send a link out to users to pin to their environment. Remember that 
the signed in user viewing this report must be assigned tasks due in the next two weeks in order to see 
any results. In "Report Settings", select the default tab to show as the "Details" tab to see the final 
product as indicated below. 

NOTE: If you are adding this report to a dashboard, I would also recommend changing in your 
report settings, under “When the report loads on a dashboard, show:” increase the number of 
items to 200 to help your Project Owners and Audit Teams and make sure they see everything.

Report recipes  |  My Work, Ready to Start
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My Tagged Update Threads by Project
R E P O R T  R E C I P E S

Submitted by: Monique Evans

Company: Stanley Black & Decker

Prep: 7 minutes

Yield: Everyone can easily see a list of all tagged updates, like an email inbox. Comes in 
handy when returning from vacation.

Serves: Anybody that gets tagged on messages

Report type: Note

Report recipes  |  My Tagged Update Threads by Project

(In the Last Week)
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My Tagged Update Threads by Project
Detailed instructions

Columns: All are renamed out of the box except column 4 which requires text mode.
•	 Column 1 – Note >> Note Text
•	 Column 2 – Note >> Entry Date

•	 Sort by the column First and sort it descending (Z-A)
•	 Advanced Options
•	 Rename to Update Sent
•	 Field Format: 10/17/60 4:00 AM

•	 Column 3 – Owner >> Name
•	 Advanced Options
•	 Rename to Posted By

•	 Column 4 - Click "+ Add Column" and "Switch to Text Mode"; paste in the following.
displayname= Tagged
listdelimiter=<div>
listmethod=nested(tags).lists
textmode=true
type=iterate
valuefield=user:name
valueformat=HTML

•	 Column 5 – Project >> Name
•	 Advanced Options
•	 Rename to Click Here to Open Project

Report recipes  |  My Tagged Update Threads by Project

Filters: Click “Switch to Text Mode”; Paste in the following
EXISTS:a:$$EXISTSMOD=EXISTS
EXISTS:a:$$OBJCODE=NTAG
EXISTS:a:note:threadID=FIELD:threadID
EXISTS:a:userID=$$USER.ID
entryDate=$$TODAYb-1w
entryDate_Mod=between
entryDate_Range=$$TODAYe

	 **If you wish to change the date range the bold text is where you would do it

See next page for final product.

Groupings: Group by Project Name.  			   Charts: No charts needed.

Step 1: Create a Note object type report and add the columns and filters as below.
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My Tagged Update Threads by Project
Final product.

Report recipes  |  My Tagged Update Threads by Project

Step 2: Share with everyone and relish in the applause.
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Workfront FAQs
R E P O R T  R E C I P E S

Submitted by: Richard Leek

Company: Vantage Clever

Prep: 1 hour (but should be continually developed and improved over time)

Yield: This report is great for users / organizations that are relatively new to using Adobe Workfront! It 
enables you to display frequently asked questions about the system that are specific to your configuration 
and your organization. You can pin this report to your user’s UI via layout templates so that they can easily 
access answers to the most frequently asked questions about Adobe Workfront in your organization!

Serves: Your general Adobe Workfront user population

Report type: Project

Report recipes  |  Workfront FAQs
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Workfront FAQs
Detailed instructions

Report recipes  |  Workfront FAQs

See next page for more detailed instructions

Step 4: Add any supporting documents to the tasks, such as screen shots or screen recordings.

Step 5: Build a task object report. Instructions start on the next page.

Step 6: Add your report to a dashboard and pin it to your user’s UI within a layout template.

Columns: Text mode is required.

Step 1: First create a project in Workfront and populate it with tasks. Populate task names with the 
questions about Workfront. Populate the task descriptions with answers to these questions

Step 2: Add Parent tasks to your project and name these by question category. (i.e. General Queries, UI 
Queries, Task Queries, Reporting Queries). Organize your tasks into parent child relationships.

Step 3: Paste the URL to the relevant help article on Workfront One into the URL field of each task.
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Workfront FAQs
Detailed instructions

Report recipes  |  Workfront FAQs

See next page for more detailed instructions

Question Column Text Mode:
This column returns the task name, but I like to apply the following text mode to ensure that the 
name is not clickable in my report and also to format it into bold text.

displayname=Question
isInlineEditable=false
styledef.case.0.comparison.icon=false
styledef.case.0.comparison.leftmethod=name
styledef.case.0.comparison.lefttext=name
styledef.case.0.comparison.operator=notblank
styledef.case.0.comparison.operatortype=string
styledef.case.0.comparison.righttext=
styledef.case.0.comparison.trueproperty.0.name=fontstyle
styledef.case.0.comparison.trueproperty.0.value=bold
styledef.case.0.comparison.truetext=
textmode=true
usewidths=true
valueexpression={name}
valueformat=HTML
width=150

Answer Column: Use the Task Description field but apply a Custom Column Label in Advanced 
Options to rename it to ‘Answer’.

More Info Column Text Mode:
The following text mode will take the URL entered on your tasks and embed it into a clickable 
‘click here’ within your report. 

displayname=More Info
link.url=URL
linkedname=html(URL)
textmode=true
usewidths=true
valueexpression=IF(ISBLANK({URL}),"","Click here")
valueformat=HTML
width=50
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Workfront FAQs
Detailed instructions

Report recipes  |  Workfront FAQs

See next page for more detailed instructions

Supporting Documents Column Text Mode:
The following text mode will display the document names and a clickable link to your documents 
for any files uploaded to your tasks. PLEASE NOTE: You will need to replace ‘YOURDOMAIN’ with 
the domain of your Adobe Workfront instance. 

displayname=Supporting Documents
listdelimiter=<br>
listmethod=nested(documents).lists
textmode=true
type=iterate
usewidths=true
valueexpression=CONCAT({name}," - https://YOURDOMAIN.my.workfront.com/document/
view?ID=",{ID})
valueformat=HTML
width=100

Filters: Here are the filters to use:

**Note from Workfront: When copying and pasting text mode from 

this Cookbook PDF into your Workfront report, a new line character 

(which is a line break) is inserted at the end of the first line of the 

valueexpression. You will need to remove the new line character to 

ensure that the text mode delivers accurate results.
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Workfront FAQs
Detailed instructions and final product

Report recipes  |  Workfront FAQs

Groupings: You can just group by parent task name, however I like to rename this to ‘Subject’ 
using the below text mode code:

group.0.displayname=Subject
group.0.linkedname=parent
group.0.namekey=view.relatedcolumn
group.0.namekeyargkey.0=parent
group.0.namekeyargkey.1=name
group.0.valuefield=parent:name
group.0.valueformat=string
textmode=true

Charts: No Charts needed

The final report should look like this:

As your users start to use Workfront, no doubt there will be regular questions that come up. Be 
sure to identify any common questions that arise and add them to your Project so that they pull 
into your report. This will ensure that your userbase can get answers to their most common 
questions quickly and easily and will aid in user adoption of Adobe Workfront.
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My People's Work 
—Universal Dashboard

R E P O R T  R E C I P E S

Please note:
•	 All users involved must have a manager or 

be a manager. 

•	 All users doing work must be assigned tasks 
or requests or own projects.

•	 You must have a “Manager Names” 
calculated field on each user on their user 
custom form. (see next page for how to 
build calculation)

•	 View access to work in reports

Submitted by: Skye Hansen

Company: T-Mobile

Prep: 15 minutes (Just copy and paste the textmode below into 6 different reports)

Yield: This is meant to yield 6 reports in one dashboard that anyone can use to see themselves, a 
manager can use to see their direct reports, and that their manager can use to see all teams under them 
(and so on). i.e. a universal dashboard.

Serves: People, People managers, People managers’ Managers, People managers’ Managers’ Managers, 
and so on.

Report type: Assignment, Project (all pulled into a Dashboard)

Report recipes  |  My People's Work Universal Dashboard

Our suggestion is to create some kind of leader 

or manager role for each group. If this role 

is shared to the portfolio or program level, 

anyone assigned to the role will be able to see 

all the projects (and hence tasks and requests) 

that are stored there.



28

© 2021 Adobe. All rights reserved.

Adobe and the Adobe logo are either registered 
trademarks or trademarks of Adobe in the United 
States and/or other countries.

My People's Work Universal Dashboard
Detailed instructions

opTask:percentComplete=100
opTask:percentComplete_Mod=lt
opTaskID_Mod=notblank
project:statusEquatesWith=CUR	 PLN
project:statusEquatesWith_Mod=in
DE:assignedTo:SYS Manager Hierarchy=$$USER.name
DE:assignedTo:SYS Manager Hierarchy_Mod=cicontains
status=DN
status_Mod=notin
OR:1:assignedToID=$$USER.ID
OR:1:assignedToID_Mod=in
OR:1:opTask:percentComplete=100
OR:1:opTask:percentComplete_Mod=lt
OR:1:opTaskID_Mod=notblank
OR:1:project:statusEquatesWith=CUR	 PLN
OR:1:project:statusEquatesWith_Mod=in
OR:1:status=DN
OR:1:status_Mod=notin

Report recipes  |  My People's Work Universal Dashboard

See next page for more details.

Assignment 1: (Open Requests)

Step 1: If you don't already have one, you must bulk attach a custom form to all your users, and add 
the calculated field below to that form. In this example, we have called ours “SYS Manager Hierarchy”. 
Remember, if you don't have a managers calculated field, you'll need to create the empty field first, 
save the form, and then go back and populate the calculation.  

The calculation is therefore: CONCAT(IF(ISBLANK(Manager.Manager.Manager.Manager.SYS 
Manager Hierarchy),"",CONCAT(Manager.Manager.Manager.Manager.SYS Manager Hierarchy," 
- ")),IF(ISBLANK(Manager.Manager.Manager ID),"",CONCAT(Manager.Manager.Manager.Name," - 
")),IF(ISBLANK(Manager.Manager ID),"",CONCAT(Manager.Manager.Name," - ")),IF(ISBLANK(Manager 
ID),Name,CONCAT(Manager.Name," - ",Name)))

Step 2: Create 4 assignment reports and 2 project reports and copy/paste the following textmode as 
a filter (you can switch back to standard mode when you’re done—this just makes it easy to create 
the report). Change all reports to show charts. We suggest grouping the “Open” charts by Assigned To 
Name or Project Owner name and the “All” charts to group by some sort of date field by month (either 
Entry Date or Planned Completion Date). We also used Bar charts for the “Open”—these can get 
lengthy because of the number of users involved. We used Column charts for the “All” since there are 
only 12 columns possible in each of these reports.

**Note from Workfront: When copying and pasting text mode from this Cookbook PDF into your Workfront report, a line break 
is inserted at the end of the lines to wrap the text. You will need to remove the new line character to ensure that the text 
mode delivers accurate results.
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My People's Work Universal Dashboard
Detailed instructions

opTaskID_Mod=notblank
opTask:plannedCompletionDate=$$TODAY-1y
opTask:plannedCompletionDate_Mod=between
opTask:plannedCompletionDate_Range=$$TODAY
DE:assignedTo:SYS Manager Hierarchy=$$USER.name
DE:assignedTo:SYS Manager Hierarchy_Mod=cicontains
OR:1:assignedToID=$$USER.ID
OR:1:assignedToID_Mod=in
OR:1:opTaskID_Mod=notblank
OR:1:opTask:plannedCompletionDate=$$TODAY-1y
OR:1:opTask:plannedCompletionDate_Mod=between
OR:1:opTask:plannedCompletionDate_Range=$$TODAY

Report recipes  |  My People's Work Universal Dashboard

See next page for more details.

Assignment 3: (All Requests past year)

project:statusEquatesWith=CUR	 PLN
project:statusEquatesWith_Mod=in
task:percentComplete=100
task:percentComplete_Mod=lt
DE:assignedTo:SYS Manager Hierarchy=$$USER.name
DE:assignedTo:SYS Manager Hierarchy_Mod=cicontains
taskID_Mod=notblank
status=DN
status_Mod=notin
OR:1:assignedToID=$$USER.ID
OR:1:assignedToID_Mod=in
OR:1:project:statusEquatesWith=CUR	 PLN
OR:1:project:statusEquatesWith_Mod=in
OR:1:task:percentComplete=100
OR:1:task:percentComplete_Mod=lt
OR:1:taskID_Mod=notblank
OR:1:status=DN
OR:1:status_Mod=notin

Assignment 2: (Open Tasks)



30

© 2021 Adobe. All rights reserved.

Adobe and the Adobe logo are either registered 
trademarks or trademarks of Adobe in the United 
States and/or other countries.

My People's Work Universal Dashboard
Detailed instructions

DE:owner:SYS Manager Hierarchy=$$USER.name
DE:owner:SYS Manager Hierarchy_Mod=cicontains
statusEquatesWith=CUR	 PLN	 ONH
statusEquatesWith_Mod=in
OR:1:statusEquatesWith=CUR	 PLN	 ONH
OR:1:statusEquatesWith_Mod=in
OR:1:ownerID=$$USER.ID
OR:1:ownerID_Mod=in

Report recipes  |  My People's Work Universal Dashboard

See next page for more details and the final product.

Project 1: (Open Projects)

entryDate=$$TODAY-1y
entryDate_Mod=between
entryDate_Range=$$TODAY
DE:owner:SYS Manager Hierarchy=$$USER.name
DE:owner:SYS Manager Hierarchy_Mod=cicontains
OR:1:entryDate=$$TODAY-1y
OR:1:entryDate_Mod=between
OR:1:entryDate_Range=$$TODAY
OR:1:ownerID=$$USER.ID
OR:1:ownerID_Mod=in

Project 2: (All Projects past year)

task:plannedCompletionDate=$$TODAY-1y
task:plannedCompletionDate_Mod=between
task:plannedCompletionDate_Range=$$TODAY
DE:assignedTo:SYS Manager Hierarchy=$$USER.name
DE:assignedTo:SYS Manager Hierarchy_Mod=cicontains
taskID_Mod=notblank
OR:1:assignedToID=$$USER.ID
OR:1:assignedToID_Mod=in
OR:1:task:plannedCompletionDate=$$TODAY-1y
OR:1:task:plannedCompletionDate_Mod=between
OR:1:task:plannedCompletionDate_Range=$$TODAY
OR:1:taskID_Mod=notblank

Assignment 4: (All Tasks past year)
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My People's Work Universal Dashboard
Detailed instructions and final product.

Report recipes  |  My People's Work Universal Dashboard

Step 3: Add all 6 charts to a dashboard. It should look something like this.

Columns: none needed as this is more of a charts situation
Filters: see Step 2 above
Groupings: see Step 2 above, but if serving this up to Director or VP level, we recommend you consider 
grouping the Open reports by Home Team name instead of individual contributors as this may be a bit 
too granular.
Charts: see Step 2 above
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Project and Task Approval Workflow Details
R E P O R T  R E C I P E S

Submitted by: Teale McCleaf 

Company: Rego Consulting at Google

Prep: 20-30 minutes

Yield: End-to-End approval workflow details about a Project submitted for approval via a 
Request Queue and Tasks within that same project that must be completed in order for the 
Project request to be approved by committee.

Serves: Leadership Team

Report type: Project

Report recipes  |  Project and Task Approval Workflow Details
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Project and Task Approval Workflow Details
Detailed instructions

Step 1: Create a project report.
Columns: Add the following fields to the report
•	 Project Name
•	 Project Owner
•	 Converted Issue Originator >> Name
•	 Project >> Status (this will not become part of the stacked columns)

**NOTE** We’re going to stack columns so notice that we’re inserting blank columns in front of 
the fields that will be stacked.

Report recipes  |  Project and Task Approval Workflow Details

Step 2: Add Labels to each field
Click the blank column and input the following textmode code:

See next page for more instructions.

value=<strong>Label: &nbsp;&nbsp</strong>
valueformat=HTML
width=1
sharecol=true
displayname=Project Details

Replace the word “Label” with the name of the column to the right, i.e. Name as shown in the image, 
and Save. Click the blank column and input the same textmode code with one addition.

value=<hr><strong>Label:&nbsp;&nbsp</strong>
valueformat=HTML
width=1
sharecol=true
displayname=This line can be removed

*Note from Workfront: "Converted Risk or Issue Originator" 

is based on a customized name this customer is using. The 

standard default name is "Converted Issue Originator".
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Project and Task Approval Workflow Details
Detailed instructions

Repeat Step 2 for the Originator field and the final textmode code will look like this:

Report recipes  |  Project and Task Approval Workflow Details

See next page for more instructions.

column.0.displayname=Project Details
column.0.sharecol=true
column.0.textmode=true
column.0.value=<strong><p style="color:DodgerBlue;">Name:  <br></p></strong>
column.0.valueformat=HTML
column.0.width=200
column.1.descriptionkey=name
column.1.link.linkproperty.0.name=ID
column.1.link.linkproperty.0.valuefield=ID
column.1.link.linkproperty.0.valueformat=int
column.1.link.lookup=link.view
column.1.link.valuefield=objCode
column.1.link.valueformat=val
column.1.linkedname=direct
column.1.listsort=string(name)
column.1.namekey=name.abbr
column.1.querysort=name
column.1.section=0
column.1.sharecol=true
column.1.shortview=true
column.1.textmode=true
column.1.valuefield=name
column.1.valueformat=HTML
column.1.width=200
column.2.sharecol=true
column.2.textmode=true
column.2.value=<hr><strong>Owner: <br></strong>
column.2.valueformat=HTML
column.2.width=200
column.3.displayname=Owner
column.3.linkedname=portfolio
column.3.namekey=view.relatedcolumn
column.3.namekeyargkey.0=portfolio
column.3.namekeyargkey.1=owner:name
column.3.querysort=portfolio:owner:name
column.3.sharecol=true
column.3.textmode=true
column.3.usewidths=true
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Project and Task Approval Workflow Details
Detailed instructions
Text mode continued from previous page:

Report recipes  |  Project and Task Approval Workflow Details

See next page for more instructions.

column.3.valuefield=portfolio:owner:name
column.3.valueformat=HTML
column.3.width=200
column.4.sharecol=true
column.4.textmode=true
column.4.value=<hr><strong>Originator:  <br></strong>
column.4.valueformat=HTML
column.4.width=200
column.5.displayname=Originator Name
column.5.textmode=true
column.5.usewidths=true
column.5.valuefield=convertedOpTaskOriginator:name
column.5.valueformat=HTML
column.5.width=200

Optional Variations:

<strong><p style="color:DodgerBlue;">Name:  <br></p></strong> - Add this to make the label 
blue (or add any other desired color)
<hr> - adds a line in the break between fields in the column
Looks like this:

In my case, the Status field remains outside of the Project Details stacked column, however, if 
desired, follow the previous steps to add it to the bottom of that column.
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Project and Task Approval Workflow Details
Detailed instructions continued
Step 3:  Add Project Approval Flow Details
Add new columns for:
•	 Project >> Approval Path Start Date
•	 Project >> Approver Statuses - This is a collection 
•	 Project >> Approval Path Completion Date
Add a blank column in front of each of the new columns and repeat the steps above to add a 
Label to each.
Your columns will should look like this:

Report recipes  |  Project and Task Approval Workflow Details

See next page for more instructions.

Now we need to add the Approver Statuses. In this case, we want to show the approval step(s) 
and the individual(s) responsible for the approval that is pending. To do this, we reference the 
collection approverStatuses with a valueexpression like this:

column.10.listdelimiter=<br>  
column.10.textmode=true
column.10.listmethod=nested(approverStatuses).lists
column.10.valueformat=HTML
column.10.valueexpression=CONCAT({approvalStep}," - ", {approvedBy}.{name}, " ")
column.10.sharecol=true
column.10.usewidths=true
column.10.displayname=Approver
column.10.type=iterate
column.10.width=200

Starting with the Approval Start Date column, Click to Edit and add the following at the bottom of 
the textmode code:

sharecol=true 

Save
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Project and Task Approval Workflow Details
Detailed instructions continued
Remain on the Project Approval Flow Details column - Click to Edit and input: 
column.X.sharecol=true (X being whatever number is the last on the list, i.e., 
column.8.sharecol=true)
Repeat until all columns are stacked and it will look like this:
(Names have been etched out)

Report recipes  |  Project and Task Approval Workflow Details

See next page for more instructions.

column.7.usewidths=true
column.7.displayname=Project Approval Flow Details
column.7.width=200
column.7.textmode=true
column.7.sharecol=true
column.7.value=<strong>Approval Start Date:</strong>
column.7.valueformat=HTML
column.8.querysort=approvalStartDate
column.8.namekey=approvalStartDate
column.8.sharecol=true
column.8.valueformat=atDate
column.8.valuefield=approvalStartDate
column.8.textmode=true
column.8.linkedname=direct
column.9.sharecol=true
column.9.textmode=true
column.9.width=200
column.9.valueformat=HTML
column.9.value=<hr><strong>Approver by Stage:<br></strong>
column.10.valueformat=HTML
column.10.valueexpression=CONCAT({approvalStep}," - ", {approvedBy}.{name}, " ")
column.10.sharecol=true

Final textmode code looks like this:
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Project and Task Approval Workflow Details
Detailed instructions continued

Report recipes  |  Project and Task Approval Workflow Details

See next page for more instructions.

column.10.usewidths=true
column.10.displayname=Approver
column.10.type=iterate
column.10.width=200
column.10.listdelimiter=<br>
column.10.textmode=true
column.10.listmethod=nested(approverStatuses).lists
column.11.width=200
column.11.valueformat=HTML
column.11.sharecol=true
column.11.textmode=true
column.11.value=<hr><strong>Approval Completion Date:</strong>
column.12.querysort=approvalCompletionDate
column.12.textmode=true
column.12.width=200
column.12.valuefield=approvalCompletionDate
column.12.usewidths=true
column.12.namekey=approvalCompletionDate
column.12.displayname=
column.12.linkedname=direct
column.12.valueformat=atDate

Optional - Add Percent Complete for Specific tasks in the schedule
Precursor - the names of the tasks must remain constant for this to work so this can be ideal for 
teams/groups that use templates.
Use the following textmode code:

valueformat=HTML
textmode=true
type=iterate
listdelimiter=</>
displayname=Column Name
listmethod=nested(tasks).lists
valueexpression=IF(CONTAINS("INSERT TASK NAME",{name}),CONCAT({percentComplete},"%")
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Project and Task Approval Workflow Details
Detailed instructions continued

Report recipes  |  Project and Task Approval Workflow Details

See next page for more instructions.

To add additional columns, repeat this and update the task name to include different columns.  
Mine looks like this:

valueformat=HTML
textmode=true
type=iterate
listdelimiter=</>
displayname=Review Dates
listmethod=nested(tasks).lists
valueexpression=IF(CONTAINS("INSERT TASK NAME",{name}), {approvalStartDate})

Optional - Add Approval Path Start and End dates for specific tasks in schedule.
Using the same textmode for collections, here’s an example: 

Repeat this and change the valueexpression to include the approvalCompletionDate, add Labels 
and stack the columns as shown above to complete.  Mine looks like this:
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Project and Task Approval Workflow Details
Detailed instructions and final product.

Report recipes  |  Project and Task Approval Workflow Details

Filters: 
Since the report is to review projects pending approval, add a filter for Project Status = 
IDA or REQ, then switch to textmode and add “:A” to the end of REQ as shown below. 
This will get the system to show “Requested - Pending Approval” projects.  
Mine looks like this: 

portfolioID=5efa5df000c20330c7e7441a5b6e090d	 5f1f1196001b1e01836d2f7b5bce5c5e	
portfolioID_Mod=in
status=IDA	 REQ:A
status_Mod=in

Groupings: No groupings needed
Charts: No charts needed

Final Product
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Contracts Pending Approval
R E P O R T  R E C I P E S

Submitted by: Alison Wells

Company: Community Medical Centers

Prep: 30-120 minutes depending on components already existing in your system.

Yield: We created a custom form field to track contracts in the Workfront approval process with 
elapsed time, with capital (vs expense) contracts highlighted.  Can be used to track anything you are 
approving, not just contracts because this is based on a custom form field.

Serves: Leadership in our environment. It would depend on what you are tracking.

Report type: Task

Report recipes  |  Contracts pending Approval
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Contracts Pending Approval
Step-by-step directions

 Step 4: On the Columns (View) tab, add the following columns and click Apply.
•	 Project Name
•	 Sponsor Name
•	 Project Description
•	 Project Planned Start Date
•	 Project Planned Completion Date
•	 Project Percent Complete
•	 Project Approval Path Start Date
•	 Current Approval Stage Name
•	 Project Approval Path Start Date (yes, add a second instance)

Report recipes  | Contracts pending  Approval

 Step 5: On the Filters tab, set the following filters and click Apply
•	 Current Approval Stage >> Entry Date = Not Null
•	 Project Approval Path Start Date >> =  Not Null
•	 Project Status>> = Not Equal Complete, Dead or Rejected
•	 Project CMC Contract – Initiator is Not Blank:  This is a required Custom Form field for us 

and is used to identify a Contract project.  Replace this filter item with how YOU will identify 
desired Projects in your environment.

See next page for detailed instructions.

Step 1: Create Approval Processes if you do not already have them in place.  

Step 2: Create Templates for your Capital and Expense Contracts, giving each the appropriate steps.  We 
will be using the Template name to determine whether the contract is Capital or Expense.  Alternatively, 
you could use a Custom Form and Field(s), or other methods, to accomplish the same thing. You'll need 
at least on one project or custom form in the approval process for testing.

Step 3: Create a new Project Report and name as desired. Click Apply. 
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Contracts Pending Approval
Step-by-step directions

Step 6: On the Columns (View) tab, we are now going to customize the columns we previously 
added, from left to right, starting with Project Name.
	• Click on the Name column, then choose Advanced Options and add a Column Rule:  When the 

Template Name Contains “Capital”, Text Format is Bold.  Click Save.  We use Capital and Expense 
Templates, which are named accordingly, and therefore use this to determine what type of 
contract we have.  You should use what works best in your environment.

Report recipes  |  Contracts pending Approval

	• Click on the Sponsor: Name column, then choose Advanced 
Options.  Add a custom column label of “Sponsor” and click 
Save.

	• Repeat to apply custom labels to these other columns:
	• Planned Start Date to “Start On"
	• Planned Completion Date to “Due On”
	• Approval Path Start Date to “Approval Start”
	• Current Approval Stage: Name to “Current Stage"

	• Now, click on the second instance of Approval Path Start Date, then Switch to Text Mode.  We are 
going to change this column to a custom calculation to give us the amount of time the approval has 
been waiting.  The initial text mode you will see is this, make the changes as noted:

See next page for detailed instructions.
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Contracts Pending Approval
Step-by-step directions

Report recipes  |  Contracts pending Approval

See next page for final product.

Starting Text Mode Changes to Make

valuefield=approvalStartDate valueexpression=ROUND(DATEDIFF($$TODAY,{approvalStartDate},0))

querysort=approvalStartDate
valueformat=atDate valueformat=HTML
displayname= displayname=Approval Duration
linkedname=direct
namekey=approvalStartDate

shortview=true

Your ending text mode should look like this (and it's okay if the lines are rearranged, it happens sometimes.)

Step 7: If your Templates are not giving rights to all Contract projects to your leadership team or placing 
them in a Portfolio that everyone has access to is not an option, you may want to set this report to run 
as yourself (Admin) to ensure everyone can see all the Contracts.  To do this, click on Report Options and 
enter your name in the Run this report with the Access Rights of box:

Step 8: Click Save + Close because you are DONE!

Columns: See Step 4 above.
Filters: See Step 5 above.
Groupings: No groupings needed. 
Charts: No charts needed.

valueexpression=ROUND(DATEDIFF($$TODAY,{approvalStartDate},0))
valueformat=HTML
linkedname=direct
displayname=Approval Duration
namekey=approvalStartDate
textmode=true
querysort=approvalStartDate
shortview=true
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Contracts Pending Approval
Final product

Report recipes  |  Contracts pending  Approval
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Creative Production Cycle Time
R E P O R T  R E C I P E S

Submitted by: Amy Zakrzewski and Heather Kulbacki

Company: Thermo Fisher Scientific

Prep: 15 minutes

Yield: This report will show, by team, how long a particular task takes to complete for the 
prompted actual completion date.

Serves: Leadership Team

Report type: Task

Report recipes  |  Creative Production Cycle Time
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Creative Production Cycle Time
Detailed instructions

Columns: Here are the out-of-the-box names for the columns to use in this report.:
Task > Name
•	 Project > Name
•	 Task > Planned Start Date
•	 Task > Planned Completion Date
•	 Task > Actual Start Date
•	 Task > Actual Completion Date
•	 Task > Actual Hours, Summarized by Average
•	 Task > Actual Duration, Summarized by Average
•	 Custom Column for Project > Squad (we call Teams, Squads and this is a custom field on one 

of our project forms)

Report recipes  |   Creative Production Cycle Time

Filters: No text mode is required! Here are the filters to use:
•	 Task > Number of Children = 0, if it’s a single task you are tracking the cycle time of
•	 Project > Company ID = appropriate company if you have multiple companies in your instance
•	 Task > Name Contains “Task you are looking to track the cycle time of ”
•	 Any filters to filter out projects that you don’t want pulled into this report, such as status = 

Canceled, or if you don’t want projects that contain a certain answer to a custom field

See next page for final product.

Groupings: We group by Task Status then Squad (a custom field on a project form).

Prompts: Actual completion date.

Step 1: Create a Task object type report. You'll need a task that you want to track across projects that 
is consistently named across all those projects. You'll aslo need either: 1) Users to consistently change 
the task status to In Progress when they begin working on a task or 2) In the Setup area for each team 
you want to track, set the “Work on it” button to correspond to an “in progress” status.
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Creative Production Cycle Time
Detailed instructions and final product.

Report recipes  |  Creative Production Cycle Time

Charts: 
Bar Chart
Bottom (X) Axis = Task > Actual Duration
Summarized by = Average
Left (Y) Axis = Project > Squad

Final Product
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Need more resources or want to join more conversations about reporting? 
Check out the Adobe Workfront Community. 
one.workfront.com/s/community

Now it's your turn. 
Happy cooking! 


